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Topic 1. Workflow & Interface 

AE Workspace 
AE biedt een flexibele, aanpasbare werkruimte aan. Het hoofdvenster van het programma 
wordt het application window (A) genoemd. Panels worden georganiseerd in dit venster in 
een workspace. De standaard workspace bevat verschillende groepen en Panels, zoals 
hieronder afgebeeld.

 

A. Application window B. Toolbox C. Project panel D. Composition panel E. Timeline panel F. Time 
graph G. Grouped panels: Effects, Type, Info, ... 

Je kan een workspace aanpassen door de Panels te slepen naar een andere locatie die 
beter bij je workflow past. De Panels kan je verplaatsen naar een nieuwe locatie, uit een 
andere groep halen, Panels naast elkaar plaatsen en een Panel losmaken zodat het zweeft 
boven de application window. Van zodra je Panels verplaatst zullen deze automatisch van 
grootte veranderen om binnen het venster te passen. 

Iedere Motion Designer heeft zijn eigen manier van werken. After Effects (AE) maakt het 
eenvoudig om je eigen workspace samen te stellen met de tools die je vaak gebruikt en 
deze op te slaan als een custom workspace. Om van workspace te veranderen of een 
nieuwe aan te maken ga je naar Window > Workspace. 
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Een panel bevat vaak meer info dan dat er visueel in past. Met de shortcut ` (of ~ op qwerty) 
plaats je het Panel waar de muiscursor zich bevindt tijdelijk fullscreen. Gebruik nogmaals ` 
om terug te keren. 

Importing Footage 
Een footage item is de basiseenheid in een AE project. Je kan verschillende type footage 
items importeren zoals o.a moving-image files, still-image files, still-image sequences, audio 
files, layered Photoshop of Illustrator files en zelfs andere AE of Premiere Pro projecten. 

Er zijn verschillende manieren om assets te importeren: 

1. ⌘+I 
2. Drag & drop op het project panel 
3. Dubbelklik het project panel 
4. File > import > file 
5. Rechterklik > import > file 

Je kan still images importeren als individuele footage items of als een sequentie van 
beelden. Dit wordt dan één footage item in je project. Om verschillende images als een 
sequentie in te laden, moeten alle images in dezelfde map staan een zelfde numerieke of 
alfabetisch patroon hebben als naam (voorbeeld: image1, image2, image3..). 

Photoshop of Illustrator files kan je ook gemakkelijk importeren. Bij deze bestanden krijg je 
de optie om ze als één layer of elke layer afzonderlijk te importeren; je krijgt verschillende 
import opties: footage, composition of composition - retain layer sizes.  

Het aantal assets / layers loopt snel op in een AE project. Besteed daarom aandacht aan 
een verzorgde layer structuur in Photoshop en/of Illustrator wanneer je de assets voorbereid. 
Maak je Canvas / Artboard in AI/PS ook even groot als je AE project. 

Pas je de inhoud van een layer in AI/PS nog aan, dan wordt dit automatisch upgedate in AE. 
Voeg je echter een nieuwe layer toe nadat je de file in AE importeerde, dan zal deze niet 
automatisch toegevoegd worden en dien je dit manueel te doen. 
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Footage  

Importeert de Photoshop file als één layer. Je krijgt 
de optie om alle layers samen te voegen (Merged 
Layers) of enkel een specifieke layer te selecteren 
(Choose Layer). 

Composition  

Creëert een nieuwe compositie met elke layer van 
de Photoshop file als een individuele layer binnen 
de compositie. De grootte van elke individuele Layer is gelijk aan de grootte van de 
compositie.  

Dit maakt het geheel moeilijker om te animeren omdat het ankerpunt van elke layer in het 
midden van de compositie staat, ongeacht waar de content van die layer zich bevindt. 

Editable Layer Styles draagt de layer effecten over van Photoshop naar AE zodat je deze 
kan animeren. 

Composition - Retain Layer Sizes 

Grotendeels hetzelfde als Composition, met als uitzondering dat het ankerpunt van elke 
layer in het midden van de layer staat en niet in het midden van de compositie. De grootte 
(bounding box) van elke layer is exact de grootte van de content. 
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Compositions 
Alle animaties, layers en effecten plaats je in een compositie. Een AE compositie bevat 
zowel een ruimtelijke (space) als tijdelijke (time) dimensie. Composities bevatten meestal 
één of meerdere layers.  

Om een nieuwe compositie te maken, klik je op het New Composition icon in het project 
panel en geeft je handmatig alle settings in, of sleep je een footage item op dit icoon. 
Wanneer je footage sleept op het icoon zal AE zelf automatisch een nieuwe compositie 
aanmaken en alle settings gelijkstellen aan de settings van het footage item. 

Compositie settings kan je manueel invullen of je kan een preset selecteren die automatisch 
de frame size (breedte en hoogte), pixel aspect ratio, frame rate en vele andere settings 
invult. 

Op eender welk moment kan je de settings van een compositie aanpassen door naar 
Composition > Composition Settings te gaan of door de snelkoppeling ⌘+K te gebruiken. 
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A. Composition Name 

De naam van de compositie binnen je project. Voor de main-timeline in een project hanteren 
we bij Devine de naamgeving _main. Zo staat deze steeds bovenaan in je Project Panel.  

B. Preset 

AE heeft veel vooropgestelde presets. Wij gaan deze niet gebruiken en onze eigen preset 
opstellen. 

C. Width / Height 

Dit zijn de ruimtelijke dimensies van de compositie. Met andere woorden, hoe breed en hoog 
deze is. 

D. Pixel Aspect Ratio 

De meeste digitale imaging systems tonen een beeld als een grid van kleine, vierkante 
pixels. Maar, sommige systemen, vooral diegene die compatibel moeten zijn met 
standard-definition television motion pictures, tonen een beeld als een grid van rechthoekige 
pixels. Pixel aspect ratio beschrijft dit verschil. 

F. Frame Rate 

Hoeveel frames per seconde er in de compositie zijn. Voor film is dit standaard 24 fps, 
televisie in Belgie 25fps. 

G. Duration 

Hoe lang (tijd) de compositie duurt.  

H. Background color 

De achtergrondkleur van de compositie. Dit heeft geen invloed op je render. De background 
color is enkel zichtbaar in AE. In je Composition Panel kan je ze aan -en uitzetten.  

 

Voeg je een footage item aan een compositie toe dan zal dit item de bron zijn voor een 
nieuwe layer in de compositie. Een compositie kan verschillende layers, en zelfs 
composities, bevatten. Composities in composities noemen we nesting. 
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Layers 
Layers zijn de componenten die je nodig hebt om een compositie op te vullen. Elk item dat je 
aan een compositie toevoegt — zoals een still image, video file… — wordt een nieuwe layer. 
Zonder layers zou een compositie een leeg frame zijn. 

Je kan layers ordenen door ze te verplaatsen in het Timeline Panel of ⌘+⌥+↑/↓. Een Layer 
die boven een andere layer staat zal deze bedekken, net als in Photoshop. Let op! Dit is niet 
altijd het geval. Zeker als er masks en 3D layers aan te pas komen. Nieuwe layers kan je 
aanmaken door te navigeren naar ​Layer > New > ... 

Er zijn verschillende soorten layers: 

1. Video en audio ​layers zijn gebaseerd op footage items die je importeert als 
stilstaande beelden, bewegende beelden en audio tracks. 

2. Layer die je aanmaakt in AE om​ speciale functies​ uit te voeren, zoals camera’s, 
lichten, adjustment layers en null objecten. 

3. Solid-color layers​ zijn gebaseerd op solid-color footage items in AE. 
4. Synthetic layers​ bevatten visuele elementen zoals shape layers en text layers. 
5. Precomposition layers​ gebruiken composities als brons voor de layer (nesting). 

Elke layer heeft verschillende properties, vele hiervan kunnen aangepast en geanimeerd 
worden. De basis groep van properties die elke layer bevat, is de ​Transform Group​. Elke 
Layer property is tijdelijk — ze kunnen de Layer over tijd veranderen. Sommige Layer 
Properties, zoals Opacity, hebben enkel een tijdelijke component, terwijl andere Layer 
Properties, zoals Position, ook ruimtelijke componenten bevatten — en kan de layer 
verplaatsen of aanpassen in de compositie. 

Om de Properties van een Layer te zien, vouw je de layer open door op de pijl naast de 
Layer naam te klikken. De meeste Properties hebben een stopwatch die toelaat deze 
property te animeren, met andere woorden de waarden ervan te animeren over tijd. Met de 
shortcuts P, T, S, R open je respectievelijk Positon, Opacity, Scale of Rotation property van 
de geselecteerde laag.
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Rendering 
Een render maken van je project kan enkele minuten of vele uren in beslag nemen. De tijd 
die nodig is om alles uit te renderen heeft te maken met de grootte van de compositie, 
kwaliteit, complexiteit en compressiemethode. 

Om een compositie toe te voegen aan de render queue volg je volgende stappen: 

1. Controleer de work area van de compositie. 
2. Ga naar Composition > Add to Adobe Media Encoder Queue. 
3. Klik op het formaat van de compositie om de settings aan te passen (zie labo). 
4. Sluit het settings venster en start de render door op de groene play button te klikken. 

Format 

H264 is de codec die we gebruiken bij het renderen. De preset staat op Custom, tenzij je al 
een preset het gesaved in het verleden. 

Output Name 

De naam en locatie waar de file staat eens die gerenderd is. Vergeet ook niet de audiobox 
aan te vinken als je met audio werkt in je sequentie! 

Frame Aspect Ratio 

De afmetingen van je video. Dit zal (meestal) hetzelfde zijn als de settings van je sequentie. 
Gebruik de waarden die je kreeg bij de briefing van de klant / opdracht. 

Frame Rate 

Het aantal frames per seconde. Dit moet hetzelfde zijn als je sequentie / bronmateriaal. 

Field Order 

Progressive of interlaced. Kies hier voor Progressive en vermijd Interlaced. Deze laatste 
methode wordt minder gebruikt. 

Aspect 

Pixel aspect ratio van de video. 

Bitrate Settings 

Dit bepaalt de kwaliteit van de render. 6 op 8 is een gebalanceerde setting die genoeg 
kwaliteit gevat en nog steeds soepel afspeelt.  
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Precomposing & Nesting 
Als je een aantal Layers, die al in een compositie aanwezig zijn, wil bundelen (group) dan 
kan je deze Layers precomposen. Layers precomposen plaatst deze in een nieuwe 
compositie. De nieuwe compositie neemt vervolgens de plaats in van de Layers in de 
originele compositie. 

De nieuwe geneste Layer kan je terugvinden in het project panel en opnieuw gebruiken 
doorheen je project. Je kan composities gaan nesten door een bestaande compositie te 
plaatsen in een andere compositie, juist zoals je een andere asset zou importeren in de 
compositie. 

Precomposing en nesting zijn handig om complexe composities overzichtelijk te houden. Je 
kan: 

● Hergebruiken wat je gemaakt hebt. Je maakt een animatie in een compositie en 
hergebruikt deze x aantal keer in je project. 

● Aanpassingen updaten in één keer. Wanneer je iets aanpast aan een geneste 
compositie, dan hebben die aanpassingen invloed op alle instanties waar je de 
compositie gebruikt hebt. 

● Een nieuwe set transformatie properties toevoegen aan een Layer. De Layer die de 
compositie voorstelt heeft zelf ook transform properties, naast de transform 
properties van Layers binnen die compositie. 

Om een Layer of verzameling van Layers te precomposen: Layer > Pre-compose 

of ⌘+⇧+C. Je hebt twee opties bij het precompen: Leave all Attributes in en Move all 
Attributes into the new Composition. 

Leave all attributes In 

Laat alle properties en keyframes van de precomposed layer in de originele compositie, 
toegepast op de nieuwe layer die de precompositie vertegenwoordigt. De grootte van de 
nieuwe compositie is gelijk aan de grootte van de geselecteerde layer. Deze optie is niet 
beschikbaar wanneer je meerdere layers, een text layer of shape layer selecteert.  

Move all attributes into the new composition 

Verplaatst alle properties en keyframes van de precomposed layers één niveau dieper. 
Wanneer je voor deze optie kiest, blijven alle properties van de layers op de individuele 
layers binnen de precomposition. De grootte van de nieuwe compositie is gelijk aan de 
grootte van de originele compositie en neemt niet de afmetingen van zijn content aan. 
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Crop Comp to Region of Interest 

Met Crop Comp to Region of Interest kan je de afmetingen van een 
precomp aanpassen aan de gewenste grootte. Meestal wil je de 
afmetingen nemen van je (geanimeerde) assets. 

Hiervoor markeer je eerst een Region Of Interest, die je onderaan in je Composition panel 
terugvindt. Kies vervolgens Composition > Crop Comp to Region of Interest.  
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Labo 01 - Importing Files  

 

Importeren assets 

Importeer de vector.ai file in AE en plaats deze in een nieuwe compositie. 

Je zal merken dat je geen afzonderlijke shapes kan selecteren. Dit komt doordat de 
illustrator file ‘slecht’ is opgemaakt voor animatie. Alle shapes staan in dezelfde layer. AE 
interpreteert dit dan als één shape. 

Assets voorbereiden 

We gaan de assets voorbereiden in Illustrator door elke shape in een afzonderlijke layer te 
plaatsen. (Tip: “Release To Layers”) Save deze file als een nieuwe illustrator file genaamd: 
vector2.ai 

Importeren als footage 

Importeer nu de nieuwe vector2.ai in AE en kies voor de optie: Footage. We kunnen nog 
steeds geen afzonderlijke shapes selecteren. Dit komt doordat footage gelijk staat als 
‘merge layers’ in Photoshop. De hele layer structuur wordt geflattend naar één simpele layer. 

Importeren als composition retain layer sizes 

Wil je elke layer afzonderlijk selecteren dan importeer je als composition retain layer sizes. 
Er wordt een nieuwe compositie aangemaakt en nu kan je wel de shapes selecteren. De 
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optie importeren als composition is inferieur aan de retain layer sizes. Deze gaan we dus zo 
goed als nooit gebruiken. 

Keyframe Assistant 

Eens alles verzorgd geïmporteerd is kan je via de de Keyframe Assistant snel je layers 
animeren. 

Via Animation > Keyframe Assistant > Sequence Layers… plaats je automatisch elke 
geselecteerde layer achter elkaar. Kort alle layers daarom eerst in en pas dit vervolgens toe.  

Varieer in de timeline met de overlap van de layers en bekijk telkens het resultaat. 
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Labo 02 - Ben & Jerry’s  
Bekijk sample.mp4 ter referentie. In dit reclamefilmpje gaan we de eerste 3 seconden 
proberen na te maken met de aangeleverde assets in de map assets. 

Voorbereiden van de assets  

Voor we beginnen met het project op te stellen, gaan we de assets in Photoshop detoreren. 
In Illustrator maken we alle vectors op. Let op voor elk nieuw element maken we een nieuwe 
layer, anders zal je straks in de problemen komen bij het importeren van de file.  

De jpg’s snij je uit met behulp van een mask Layer, zo kan je nog steeds aanpassingen 
maken indien nodig. Het is ook voordeliger om op deze manier te werken want AE vraagt 
dan minder rekenkracht van je toestel. 
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Aanmaken project 

Start AE op en maak een nieuwe compositie met volgende settings:  

We geven de  compositie de naam _main. Dit is niet noodzakelijk, maar maakt het ons 
gemakkelijk om het terug te vinden in het project panel. Als we dit voor elk project doen, 
weten we iedere keer dat de _main ons project zal samenvatten. 

Importeren van de assets 

Importeer alle assets in AE. De Illustrator file zal je niet als footage 
importeren omdat we elke Layer afzonderlijk willen aanspreken. 
Daarom importeer je deze als composition en kies je voor de optie 
retain Layer sizes.  

! Het is belangrijk om altijd je project verzorgd en ordelijk te houden. 
Gebruik logische naamgevingen en groepeer waar nodig. Het is niet 
alleen aangenamer om in te werken, maar bevordert ook relaties 
met collega’s. 

! Bij het importeren uit Illustrator of Photoshop worden assets tijdens 
het importeren bijgesneden volgens de document bounds. Plaats 
deze (in AI & PS) steeds volledig binnen de bounds wanneer je deze 
in AE zal animeren.  
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! Een geïmporteerde AI of PS kan je achteraf nog aanpassen en wordt automatisch 
geüpdate in AE. Voeg je achteraf extra Layers toe, dan dien je deze wel nog apart te 
importeren in AE. 

Composition opstellen 

Plaats alle assets in de compositie en maak 
volgende scène zo goed mogelijk na.  

Het is niet erg dat Ben en Jerry hun ijsjes niet 
vasthouden. Dit zullen we in een later labo 
oplossen met masks. 

Layers bewerken 

Layers kan je inkorten, verlengen of verplaatsen op de tijdlijn. De tijdlijn gaat altijd van links 
naar rechts. Als de Time Indicator de balk van de Layer niet raakt, zal de Layer niet 
zichtbaar zijn in de compositie. 

We passen de lengtes van de Layers aan zodat we een stop motion effect creëren. 

 

Composition Work Area 

De ingestelde lengte van je composition is niet noodzakelijk de lengte van de geëxporteerde 
composition. Deze wordt bepaald door je work area - en is default gelijk aan je composition 
length. De work area is de balk net boven je timecode in je timeline. Je kan deze inkorten 
met de shortcuts b en n, of met de muis. Met shortcut i spring je naar de start van je laag. 

Renderen 

Voor we de compositie _main toevoegen aan de render queue, controleren we of de work 
area de volledige lengte van de compositie omvat. Mocht dit niet het geval zijn, zou een deel 
van de animatie niet gerenderd worden. 

Vervolgens voegen we deze toe aan de render queue: Composition > Add to Adobe Media 
Encoder Queue of gebruiken we de shortcut ⌥⌘M. AE zal de compositie doorsturen naar de 
Media Encoder, waar je alle output settings kan aanpassen. Klik op het formaat van de 
compositie om dit te doen. 
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Omdat we de compositie via AE hebben verstuurt, zal Media Encoder automatisch de 
compositie settings erven. Deze zou je, indien nodig, nog steeds kunnen aanpassen. 

Uit voorzorgsmaatregelen controleren we steeds of de settings al dan niet kloppen. Als je 
een compositie met audio wil renderen, vergeet dan niet de checkbox export audio aan te 
vinken. Anders zal je nog eens de video mogen laten renderen. 

Sluit het venster en klik op de groene play button om de render queue te starten.  
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Labo 03 - Oreo 

 
Bekijk sample.mp4 ter referentie. In dit reclamefilmpje gaan we de eerste paar seconden 
proberen na te maken met de aangeleverde assets in de map assets. 

Je kan met de voorgaande kennis deze opdracht zelfstandig proberen op te lossen. 

Workflow 

Gebruik precomps en instanties hiervan om animaties te hergebruiken doorheen het project. 
Zo hoef je niet elk onderdeel telkens opnieuw te animeren. 

Je kan bijvoorbeeld een compositie ‘oreo black to white’ maken waarin de zwarte zijde van 
de Oreo eerst zichtbaar is en animeert naar de open zijde. 
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